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Introduction 

About this user guide 

This user guide is for users of the Electronic Receipting System (ERS).  This version is for 
foundation-focused Training Opportunities and Youth Guarantee programmes. 

The user guide is downloadable from www.tec.govt.nz but is best read online if you want to access 
the hyperlinks.  It is also available from the ERS online help (see Help for instructions on accessing 
it). 

Getting help 

Use the following table to decide where to get help: 

STEP COMMENTS 

1. Check the user 
guide 

The information you need is probably available in this user guide. 

2. If you still need help If you can’t find what you need in the user guide, then contact one of the following: 

IF THE PROBLEM RELATES TO … THEN … 

Queries concerning 
enrolment issues, eligibility 
criteria, funding rules etc 

Refer to the Foundation Focused Training 
Opportunities Handbook available from 
www.tec.govt.nz. 
 
Or contact the TEC Service Centre on 
0800 601 301 or servicecentre@tec.govt.nz 

Technical problems 
accessing ERS 

Contact the TEC Service Centre 0800 601 301 or 
servicecentre@tec.govt.nz. 

Technical problems with 
“ESAA login” or the “National 
Student Index” 

Contact the Ministry of Education Sector Service 
Desk at 0800 422 599 or 
sector.servicedesk@minedu.govt.nz 
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Getting started 

Obtaining username and password 

You can’t access ERS until you have approved login to ESAA (Education Sector Authentication 
and Authorisation).  ESAA is an identity management service that controls access to multiple 
education sector web-based systems by a single login (including ERS). 

If you have these approved roles, your ESAA user id and password also provides access to the 
National Student Index (NSI), Tertiary Providers Extranet, and STEO. 

If you need help getting set up in ESAA, refer ESAA downloads from www.steo.govt.nz, or contact 
the Ministry of Education Sector Service Desk (0800 422 599 or 
sector.servicedesk@minedu.govt.nz). 

Logging in 

Once you have an ESAA username and password, you can log into ERS.  The Login screen 
describes how to do this. 

Notes: 

 You will be automatically logged off your ERS session if it has been inactive for 30 minutes. 

 Each Tertiary Education Organisation (TEO) using ERS is responsible for advising the Ministry of 
Education Sector Service Desk sector.servicedesk@minedu.govt.nz when a staff member leaves their 
employment, or moves from the ERS role. 

Logging out 

Remember to logout when you’ve finished. 
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General techniques 

Mandatory fields 

Mandatory fields are marked with a red asterisk.  For example, in the screen below, both the 
“National Student Number” and “Date of Birth” fields are mandatory. 

 

Red asterisks Red asterisks 

Use the ERS buttons 

When you use ERS (or any other web-based system), it is essential to use ERS’s buttons and not 
the browser buttons, as shown here: 

 

3. And not the x button. 

1. Use these buttons 

2. Not the browser’s Back 
button … 

 

IMPORTANT:  If you use the browser to navigate or close screens, you could lose everything 
you’ve entered. 
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Menus 

Menu items appear across the top of most of the screens. 

 

These are the 
menu items.

 

This table describes those menu items: 
MENU ITEM COMMENTS 

Home Clicking the Home menu returns you to the Programmes List screen. 

User services Click the User Services menu to change any of the following: 
 Your password. 
 Your challenge response questions and answers.  
 Your ESAA profile (see note below). 
 Change organisation (only appears if you have authorisation to act on behalf of more 

than one organisation). 
 
NOTE:  Your ESAA profile contains your personal information, such as preferred name, 
telephone number(s), email address, etc. 

Help Clicking the Help menu displays a page from which you can download this user guide. 
 
Make sure you choose the ERS Help menu and not the browser Help: 

 
  

Log out Clicking the Logout menu logs you out of ERS.  See Logout screen for more detail. 
 
IMPORTANT:  Always logout when you’ve finished, so that others cannot gain unauthorised 
access to ERS. 

Don’t use the browser’s help. 

Do use ERS help. 
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Using ERS 

Once you’re logged in, you can start using ERS.  In this document, the screens are described in 
the following groups: 

TYPE OF SCREEN PURPOSE 

Programme screens There are two screens dealing with programmes: 
 The Programmes List screen lists all the programmes the TEO is authorised 

to provide. 
 The Programme Details screen lists the learners enrolled in a particular 

programme. 
These are the main screens you will use, and you will keep returning to them. 

Enrolment screens You will use this series of screens when enrolling a learner on a programme.  They 
are accessed via a programme screen. 

Other action screens These are all the other action screens (amend learner details, etc).  They are also 
accessed via a programme screen. 

Security screens This group of screens help protect ERS from unauthorised use.  They control 
logging in, changing your password, etc. 

An overview chart is available on the next page, showing how all the screens fit together. 
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Screens:  Overview chart 

This shows how the various screens link together: 
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Screens:  Programmes 

This section describes the two screens that list programmes and their details.  They are the main 
screens you will use. 

Programmes List screen 

Use the Programmes List screen to display: 

 All the programmes the TEO is authorised to provide. 

 All “parked” enrolments.  (You can park an enrolment partway through data entry if you need to clarify 
data or obtain missing data before continuing.  Everything you have entered so far will be saved.) 

The Programmes List screen first appears on logging in (see Login screen).  In many situations, 
you will return to it after making changes via the Other action screens. 

To use the screen, either: 

 Search (by entering the programme number or name or part of name; or 

 Filter the list (to reduce what’s displayed), by selecting filters from the drop-down lists. 

 

 

This area lists all 
programmes the TEO is 
approved for.  You can 
make it shorter by 
searching or filtering.

Use this area to SEARCH for a 
programme, or to FILTER the 
display to restrict the list to 
programmes meeting certain 
criteria. 

Always check that you have 
the correct TEO. 

This area lists any 
parked enrolments. 

NOTE:  You can display a programme’s 
details by clicking its number. 

 

Clicking a programme’s number (on the left) displays the Programme Details screen, which 
displays detailed information about the programme you’ve selected. 
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FIELD, BUTTON, LINK COMMENTS 

“SEARCH BY” FIELDS 

 

Number Programme number. 

Name Programme name (restricted to 30 characters). 

Search button Click this to execute the search.  The list of programmes (see below) changes to reflect 
the search criteria. 
 
NOTE:  If there is only one programme in the search result, ERS takes you directly to 
the Programme Details screen. 

Reset button Click this to clear the search fields. 

“FILTER LIST BY” FIELDS 

 

Area Northland, Bay of Plenty, etc. 

Fund Training Opportunities, Youth Guarantee. 

Status Active, Pending, Completed. 

Filter button Click this to execute the filter.  The programmes list changes to reflect the filter criteria. 

Reset button Click this to clear the filter fields. 

LIST OF PROGRAMMES 

 
PROGRAMMES LIST 

No. 
Name 
Fund 
…etc 

List of all the programmes you are approved for.  You can make it shorter by searching 
or filtering. 
 
Note: 

 The programme number (in the “No.” column) is also a link.  Click it to see 
detailed information about the programme.  The Programme Details screen 
appears. 

 If “Enrol” is visible at the end of a row, it can be clicked to enrol a new learner in 
that programme.  The Personal Details screen appears. 
NOTE:  Remember to take parked enrolments into account when deciding 
whether to accept additional enrolments. 

PARKED ENROLMENTS (AT BOTTOM OF SCREEN) 

NSN 
First name 
Last name 
…etc 

List of all parked enrolments. 
 
Note: 

 If “Select” is visible at the end of a row, it can be clicked to restart enrolment of 
the new learner.  The Personal Details screen appears. 

 If “Delete” is visible at the end of a row, it can be clicked to delete a parked 
enrolment started in error.  You will be asked to confirm the deletion.  If you 
delete the enrolment, all its data will be lost. 
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Programme Details screen 

Use the Programme Details screen to display detailed information about a particular programme, 
including: 

 Fund, start/end dates, status and payment cycle. 

 Recess periods (if applicable). 

 Number of learners currently enrolled in the programme, and the maximum permitted. 

 List of learners. 

Starting at the Programme Details screen, you can: 

 Enrol a new learner. 

 Amend a learner’s details. 

 Delete an enrolment if the placement on the programme is the same day as the learner was enrolled. 

 Withdraw a learner from the programme. 

 Record the outcome for a learner (at the 2 month post-withdrawal mark). 

The Programme Details screen appears after clicking a programme’s number in the Programmes 
List screen: 

 

Always check that you have 
the correct programme. 

Or click one of these links to amend 
a learner’s details, withdraw or 
delete them, or record an outcome.

Click this link to enrol 
a new learner. 
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FIELD, BUTTON, LINK COMMENTS 

SUMMARY DETAILS (AT TOP) 

Fund 
Programme start date 
…etc 

High-level details about the programme. 

RECESSES 

Start date 
End date 

List of recess periods (if applicable). 

LEARNERS 

Number of learners 
currently enrolled 

 
Number of learners currently enrolled in the programme, and the maximum 
permitted.   NOTE:  If “Enrol” is visible on the right hand side, it can be clicked to 
enrol a new learner in the programme.  The Personal Details screen appears. 

LIST OF LEARNERS 

NSN 
First name 
Last name 
…etc  

This is a list of all people enrolled in this programme.  Note that one or more of the 
following links may appear on the right hand side of a row: 

LINK COMMENTS 

Amend Click to amend a learner’s details.  The Amend Learner screen 
appears. 

Delete 
placement 

Click to delete a learner enrolled in error.  The Delete Placement 
screen appears.  Notes: 

 This link appears only if the programme has not yet started 
OR the learner was enrolled today.  Otherwise, you are given 
the option of “withdrawing”. 

 Learners deleted from a programme, no longer show as an 
active enrolment.  TEO funding and learner travel relating to 
this learner’s placement is cancelled and an outcome is not 
required. 

Record 
outcome 

Click to add an outcome for the learner.  The Record Outcome 
screen appears.  Notes: 

 Cannot be done until two months after withdrawal. 

 If recording the outcome is overdue by 30 days, ERS will 
automatically set the outcome to Unknown.  Only TEC will be 
able to change the outcome after it has been submitted. 

Withdraw Click if the learner is withdrawing from a programme before the 
programme end date.  The Withdraw Learner screen appears.  
Notes: 

 If you are withdrawing a learner as the result of a placement 
error, send a completed “Placement In Error” form to the TEC 
Service Centre.  The TEC will use the information you provide 
to help identify any payment adjustments that may be 
needed.  The form is available on www.tec.govt.nz. 

 The option of “withdrawing” a learner is available only if the 
programme has started AND the learner was enrolled before 
today.  Otherwise, you are given the option of “deleting”. 
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Screens:  Enrolment 

This section describes the enrolment screens.  These are the series of screens that appear when 
you enrol a learner in a programme. 

Notes: 

 Each screen is described in order of appearance. 

 The screens shown relate to the Youth Guarantee programme.  The screens vary slightly for other 
programmes. 

 

 

Personal Details screen 

Use the Personal Details screen to: 

 download the learner’s details from the National Student Index database; 

 check or update the learner’s contact details if the learner has an existing record; or 

 enter the learner’s contact details, if learner is new. 

Display it by: 
 clicking an Enrol or Select link in the Programmes List screen; or 

 clicking an Enrol link in the Programme Details screen. 

 

 

3. The remaining fields update 
automatically. 

2. Click the Lookup NSN 
button. 

1. Enter the student’s National 
Student Number and their date of 
birth. 

4.  Enter contact details for new 
learners, or update the learner’s 
contact details, if old details 
automatically populate. 

5. Click the Next button. 
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FIELD, BUTTON, LINK COMMENTS 

National Student Number 
Date of birth 

You can’t enrol a learner without an “active” NSN and matching date of birth. 

Name 
Gender 

Automatically filled when you click the Lookup NSN button. 

Lookup NSN button Click this after entering the NSN and date of birth.  The remaining fields will 
automatically fill. 
 
NSN status must be active for a learner to be enrolled. 

 If the learner doesn’t have an active NSN, it will be necessary to register 
them on the NSI via https://nsi.education.govt.nz.  (See Obtaining 
username and password if you don’t.) 

 If the learner has registered in more than one programme using different 
names (for example, “Chris Henare” in one, and “Chris Tu Henare” in 
another), all names used will be listed. 

 
NOTE: In exceptional circumstances a learner can have a duplicate NSN 
record under different names.  Please check the NSI, or call the TEC Service 
Centre for assistance when this applies. 

Clear NSN button Click this to clear the Personal Details fields (name, etc). 

Street 
Suburb 
Town/City 
Postal code 
Contact phone number 
Other phone number 

Automatically filled if the learner has previously been enrolled on another 
programme.  Amend, as appropriate, or enter details if the learner doesn’t have 
prior records. 

Next button Click this to move to the next screen. 

5. Click the Next button. 

4.  Enter contact details for new 
learners, or update the learner’s 
contact details, if old details 
automatically populate. 

3. The remaining fields update 
automatically. 

2. Click the Lookup NSN 
button. 

1. Enter the student’s National 
Student Number and their date of 
birth. 
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FIELD, BUTTON, LINK COMMENTS 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain 
missing information.  The Parking screen appears. 
 
NOTE:  Parking an enrolment saves data from all four of the enrolment 
screens, not just the one you are looking at. 

Cancel button Click this to cancel the enrolment.  Everything you’ve entered will be lost. 
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Eligibility Details screen (Training Opportunities) 
 

This section deals with the Eligibility Details screen for Training Opportunities.   
The screen for Youth Guarantee is different (see the next section). 

 

Use the Eligibility Details screen to: 

 enter data used in determining eligibility; 

 obtain an eligibility code. 

The screen appears: 

 if you click the Next button in the Personal Details screen; and 

 the enrolment is for Training Opportunities. 

Refer to the Foundation Focused Training Opportunities Handbook for a description of eligibility 
criteria (available on www.tec.govt.nz). 

 

1. Complete all relevant fields according to the 
applicable eligibility criteria. 

3. … which causes an eligibility code 
to appear here (provided you’ve 
entered all required information). 

2. Then click the “Check 
details” button … 

4. Finally, click the 
Next button. 
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FIELD, BUTTON, LINK COMMENTS 

Learner start date Date the learner will start. 

Age (as at today) The learner’s age as at today. 

Date left school The learner’s last day at school.  Note if only the year is known, you may 
use a proxy date and month, providing the year is correct. 

Last secondary school Select from the drop-down list. 

Education history Select learner’s highest educational achievement from the drop-down list.

Learner referred by Select from the drop-down list. 

Total number of weeks registered 
with Work and Income 

Weeks registered as a job seeker.  Note: 
 Obtain the total number of weeks from Work and Income’s “Client 

Basic Details Report”. 
 Ignore part weeks. 

Enter either: 
JSR number 
 

…or: 
SWN number 

JSR number is called “Client No.” on the Work and Income “Client Basic 
Details Report” and is often referred to as “SOLO” number by Work and 
Income employees. 
 
SWN number is the learner’s Social Welfare number. 

Job Seeker status Enter from the Client Basic Details Report. 

Benefit type Select from the drop-down list 

Work and Income youth client Select this if the learner is a Work and Income youth client. 

Learner attendance on Youth 
Guarantee programme within last 
3 months 

Select this if the learner attended a Youth Guarantee programme within 
the last three months. 

Learner attendance on Training 
Opportunities programme within 
last 6 months 

Select this if the learner attended a Training Opportunities programme 
within the last six months. 

Refugee Status granted Select this if the learner has been granted refugee status. 

MoE certificate of exemption date Date “effective from” on the learner’s MoE Certificate of Exemption. 

ELX number The reference number on the exemption approval letter from the MoE or 
the MoE Certificate of Exemption. 

Number of credits in Literacy The learner’s credits in approved literacy courses. 

Number of credits in Mathematics The learner’s credits in approved mathematics courses. 

Eligibility code See Check Details button, below. 

Check Details button Click this to obtain an eligibility code.  Note the following: 
 The eligibility code will replace the red warning “Need to check 

details” (to the left of the “Check details” button). 
 You won’t be able to change anything (but see Re-Enter Details 

button, below). 

Re-Enter Details button Click this to clear the eligibility code and start again.  The code will be 
cleared and you will be able to change what you’ve entered. 

Back button Click this to return to the Personal Details screen.  (You won’t lose what 
you’ve entered.) 

Next button Click this to move to the next screen. 

Park button Click this if you need to “park” the enrolment while you clarify details or 
obtain missing information.  The Parking screen appears. 
NOTE:  Parking an enrolment saves data from all four of the enrolment 
screens, not just the one you are looking at. 

Cancel button Click this to cancel the enrolment.  Everything you’ve entered will be lost. 
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Eligibility Details screen (Youth Guarantee) 
 

This section deals with the Eligibility Details screen for Youth Guarantee.   
The screen for Training Opportunities is different (see the previous section). 

 

Use the Eligibility Details screen to: 

 enter data used in determining eligibility; 

 obtain an eligibility code. 

The screen appears: 

 if you click the Next button in the Personal Details screen; and 

 the enrolment is for Youth Guarantee. 

Refer to the Foundation Focused Training Opportunities Handbook for a description of eligibility 
criteria (available on www.tec.govt.nz). 

 

1. Complete all relevant fields according to the 
applicable eligibility criteria. 

 
FIELD, BUTTON, LINK COMMENTS 

Learner start date Date the learner will start. 

Age (as at today) The learner’s age as at today. 

Date left school The learner’s last day at school.  Note if only the year is known, you 
may use a proxy date and month, providing the year is correct. 

Last secondary school Select from the drop-down list. 

Education history Select the learner’s highest educational achievement from the 
drop-down list. 

MoE certificate of exemption date Date “effective from” on the learner’s MoE Certificate of Exemption. 

4. Finally, click the 
Next button. 

3. … which causes an eligibility code 
to appear here (provided you’ve 
entered all required information). 

2. Then click the Check 
Details button … 
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FIELD, BUTTON, LINK COMMENTS 

ELX number The reference number on the exemption approval letter from the MoE 
or the MoE Certificate of Exemption. 

Number of credits in Literacy The learner’s credits in approved literacy courses. 

Number of credits in Mathematics The learner’s credits in approved mathematics courses. 

Eligibility code See Check Details button, below. 

Check Details button Click this to obtain an eligibility code.  Note the following: 
 The eligibility code will replace the red warning “Need to check 

details” (to the left of the “Check details” button). 
 You won’t be able to change anything (but see Re-Enter Details 

button, below). 

Re-Enter Details button Click this to clear the eligibility code and start again.  The code will be 
cleared and you will be able to change what you’ve entered. 

Back button Click this to return to the Personal Details screen.  (You won’t lose what 
you’ve entered.) 

Next button Click this to move to the next screen. 

Park button Click this if you need to “park” the enrolment while you clarify details or 
obtain missing information.  The Parking screen appears. 
 
NOTE:  Parking an enrolment saves data from all four of the enrolment 
screens, not just the one you are looking at. 

Cancel button Click this to cancel the enrolment.  Everything you’ve entered will be 
lost. 
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Statistical Information screen 

Use the Statistical Information screen to enter statistical information such as ethnic group, 
employment history, and so on. 

The screen appears after clicking the Next button in one the two Eligibility Details screens: 
 Next button for Training Opportunities. 

 Next button for Youth Guarantee. 

 

 

 
FIELD, BUTTON, LINK COMMENTS 

Ethnic group Select one or more by holding down the Ctrl key. 

Main tribal group Select from the drop-down list (but only if your selections included New Zealand 
Mäori). 

Other tribal affiliations Select any other tribal affiliations.  To select multiples: 
 select the first one (For example: Ngäi Tai); 
 press the Ctrl key and keep holding it down while you click your second 

selection (For example: Ngäpuhi); 
 keep doing this until you have selected all the required affiliations. 

 
WARNING:  If you forget to hold the Ctrl key down, you will have to start again. 

Employment history Select from the drop-down list. 

Prior activity Select from the drop-down list. 

Literacy needs Click this if the learner has literacy needs. 

4. Then click the 
Finish button. 

3. Also complete these fields (regardless 
of the ethnic group selected). 

 

2. If your selections include New 
Zealand Mäori, also specify a main 
tribal group… 
 
…plus any other affiliations. 

1. Select one or more 
ethnic groups. 
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FIELD, BUTTON, LINK COMMENTS 

Finish button Click the button to move to the next screen. 

Back button Click this to return to the previous screen.  (You won’t lose what you’ve entered.) 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain 
missing information.  The Parking screen appears. 
 
NOTE:  Parking an enrolment saves data from all four of the enrolment screens, not 
just the one you are looking at. 

Cancel button Click this to cancel the enrolment.  Everything you’ve entered will be lost. 
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Pre-confirmation Page 

The Pre-confirmation Page summarises everything you’ve entered in the previous enrolment 
screens  Use it to check that everything is correct before submitting the enrolment. 

The screen appears after clicking the Finish button in the Statistical Information screen. 

 

1. Check all your data entry 
against the original 
enrolment form.

     

3. Once you are certain that all details 
are correct, click the Submit button 
to send the enrolment to TEC. 

2. If everything is correct, complete 
the declaration by clicking (putting 
a tick in) this box.

 
FIELD, BUTTON, LINK COMMENTS 

Please declare the 
above to be true 

Select (tick) this field only if all the data entry is correct. 

Back button Click this to return to the previous screen.  (You won’t lose what you’ve entered.) 

Submit button Click this to submit the enrolment.  The Confirmation page appears. 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain missing 
information.  The Parking screen appears. 
 
NOTE:  Parking an enrolment saves data from all four of the enrolment screens, not just 
the one you are looking at. 

Cancel button Click this to cancel the enrolment.  Everything you’ve entered will be lost. 
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Confirmation page 

The Confirmation screen appears after clicking the Submit button in the Pre-confirmation Page.  
Use the screen to: 

 print a copy of the enrolment details for audit purposes; then 

 close the enrolment (after which you have the option of doing another enrolment in the same 
programme). 

 

 

 

1. Print the screen (see the next section, 
“Printout for audit purposes”, for details). 

2. Then click Close to return to the 
Programme List screen… 
 
…or… 
 
Click “Enrol another learner on the same 
programme” to return to the Programme 
Details screen, where you can enrol 
another learner in the same programme.

 
FIELD, BUTTON, LINK COMMENTS 

Close button Click this to return to the Programme List screen. 
 
IMPORTANT:  Make sure you print the screen first (see Printout for audit purposes below 
for details). 

Enrol Another 
Learner On The 
Same Programme 
button 

Click this to return to the Programme Details screen, where you can enrol another learner 
in the same programme. 
 
IMPORTANT:  Make sure you print the screen first (see Printout for audit purposes below 
for details). 
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Printout for audit purposes 

Printing is a crucial step and mandatory for auditing purposes.  Keep the printout of the 
Confirmation page, attach it to the enrolment form, and retain on the learners’ files. 

This is how you print the screen: 

 

Click the File menu 
and select Print. 

 

NOTE:  The File menu will look slightly different if you’re not using Microsoft Internet Explorer. 
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Screens:  Other actions 

This section describes the screens you will use to take other actions (amend a learner’s details, 
etc).  The screens are listed in alphabetical order. 

 

 

Amend Learner screen 

Use the Amend Learner screen to modify learner details (which were first entered when enrolling 
the learner into this particular programme).  The screen appears after clicking the Amend link in the 
Programme Details screen. 

 

 
FIELD, BUTTON, LINK COMMENTS 

NSN 
Name 

Use this information to confirm you’ve selected the correct learner. 

Street 
Suburb 
…etc 

Amend the learner’s address and contact details, as appropriate. 

Please declare the above to be true Select this field only if all the data entry is correct. 

Save Amendment button Click this to save the changes.   

Cancel button Click this to cancel the amendment.  Everything you’ve entered will be 
lost. 

3. Then click Save Amendment 
to save the changes. 

2. Select (tick) this field to certify that 
the information entered is correct. 

1. Add information and amend 
the screen, as appropriate. 

ERS User Guide for foundation-focused Training Opportunities and Youth Guarantee programmes Page 26 of 37 



Delete Placement screen 

The Delete Placement screen is used to confirm a deletion.  The screen appears after clicking the 
Delete Placement link in the Programme Details screen: 

 

 

NOTE:  An enrolment may only be deleted if the learner has been enrolled on the same day as you 
are deleting the enrolment, or when the programme has not started. 
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Parking screen 

Use the Parking screen to “park” an enrolment partway through data entry.  You would do this if 
you need time to clarify data or obtain missing data before continuing. 

The screen appears after clicking the Park button on any of the enrolment screens: 

 

 

 

 

Notes: 
 Parking an enrolment saves information you have entered on all four of the enrolment screens, not just 

the one you clicked the Park button in. 

 When you “un-park” an enrolment, remember to update the learner’s start date. 

 
FIELD, BUTTON, LINK COMMENTS 

Comment Explain why you are parking the enrolment.  For example “Waiting for the Client Basic 
Details Report”, “waiting for MoE letter”, and so on. 

Park This Form 
button 

Click to confirm that you want to park the enrolment.  The screen you originally came from 
appears (Programmes List or Programme Details). 

Cancel button Click this to cancel the park.  Everything you’ve entered will be lost. 

2. Then click the “Park 
this form” button. 

1. Explain why you are 
parking the enrolment. 
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Record Outcome screen 

The Record Outcome screen is used to record a learner’s labour market outcome.  Note that: 

 ERS will not allow you to do this until two months after withdrawal. 

 If an outcome is overdue by 30 days (that is, at 90 days), ERS will automatically set the outcome to 
Unknown. 

 After 30 days, or after an outcome has been entered, only TEC may change an outcome. 

 

The screen appears after clicking a Record Outcome link in the Programme Details screen. 

 

3. When you have finished 
entering everything, click 
the Save Outcome button. 

2. Click this button if there is more than one 
employer (that is. for part-time outcomes).  
Then complete the additional fields that 
appear. 

1.  Enter all relevant data into the screen. 
 
IMPORTANT:  Make sure you complete 
the correct tab (“Further education”, 
“Employment”, or “Other”). 

 

NOTE:  Which fields are visible depends on which tab you select (“Further training”, “Employment”, 
or “Other”).  The list below shows all possible fields, even though some don’t appear on all tabs. 
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FIELD, BUTTON, LINK COMMENTS 

TOP OF SCREEN 

NSN 
Name 
Learner start date 
Learner end date 

Use this information to confirm you’ve selected the correct learner. 

FURTHER TRAINING TAB 

Training outcome Select from the drop-down list. 

TEO name Name of the TEO. 

Contact person 
Contact phone number 
Fax number 
Email 

Contact person at the employer or TEO, and their contact details. 

Learner destination 
relates to programme 

Select this if the learner destination is relative to the programme the learner has 
withdrawn from. 

Comments Any additional comments you would like to make about the outcome. 

EMPLOYMENT TAB 

Employment outcome Select the learner’s labour market outcome from the drop-down list. 

Contact person 
Contact phone number 
Fax number 
Email 

Contact person at the employer and their contact details. 

Learner destination 
relates to programme 

Select this if the learner destination is relative to the programme the learner has 
withdrawn from. 

Comments Any additional comments you would like to make about the outcome. 

Add Another Employer 
button 

Click this if there is more than one employer (that is, for part-time employment).  
More fields appear allowing you to enter the second employer. 

Remove button Only visible if more than one employer has been entered.  Click this button to 
remove the employer. 

OTHER TAB 

Other outcome Select from the drop-down list. 

Comments Any additional comments you would like to make about the outcome. 

BOTTOM OF SCREEN 

Save Outcome button Click this to save the outcome. 

Cancel button Click this to cancel recording the outcome.  Everything you’ve entered will be lost.
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Withdraw Learner screen 

 

IMPORTANT:  If the enrolment was made in error, then: 

 Send a “Placement in Error” form to the TEC Service Centre to action this for you. 

 The TEC will then use the information you provide to identify any payment adjustments that may be 
needed.  (The form is available on www.tec.govt.nz.). 

 

The Withdraw Learner screen appears after clicking the Withdraw link in the Programme Details 
screen.  Use it when a learner is withdrawing from a programme before the programme end date. 

 

2. When you have finished 
entering everything, click 
the Save Withdrawal 

1.  Enter all relevant data into the screen. 
 
IMPORTANT:  Make sure you complete 
the correct tab (“Further education”, 
“Employment”, or “Other”). 

 

Notes: 

 Which fields are visible depends on which of the three tabs is selected (“Further education”, 
“Employment”, or “Other”).  The list below shows all possible fields, even though some don’t appear on 
all tabs. 

 All fields entered under “Further education” and “Employment” must be verified when entered. 
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FIELD, BUTTON, LINK COMMENTS 

NSN 
Name 
Learner start date 

Use this information to confirm you’ve selected the correct learner. 

Withdrawal date Date of withdrawal.  May be different from last date of attendance. 

Last date of attendance The last day the learner attended the programme maybe different from the 
withdrawal date.  Refer the Foundation Focused Training Opportunities 
Handbook (available from www.tec.govt.nz). 

Reason for withdrawal Select Employment, Further training, or Other. 

Employer name Name of the learner’s employer. 

TEO name Name of TEO. 

Programme name The name of the programme the learner has enrolled on. 

Hours per week Hours per week in employment or further training. 

Contact person Contact person for the employer or TEO. 

Contact phone number Contact person’s phone number. 

Save Withdrawal button Click this to save the withdrawal. 

Cancel button Click this to cancel the withdrawal.  Everything you’ve entered will be lost. 
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Screens:  Security  

This group of screens help protect ERS from unauthorised use.  The screens are listed in 
alphabetical order.  

 

 

 

Choose Organisation screen 

This screen only appears if the user has authorisation to act on behalf of more than one 
organisation.  For those users, the Choose Organisation screen appears after clicking the Login 
button in the Login screen: 

 

Click the Choose button next to the TEO you want to work as.  The Programmes List screen 
appears. 

NOTE:  You can only be logged in to one TEO at a time. 

Change organisation when already logged in 

To change TEO when you are already logged in: 

 Click the User Services menu 

 Select “Change your currently selected organisation” 

 

 

Forgotten Password screen 

Use the Forgotten Password screen when you need you’ve forgotten your password and need a 
new one.  The screen appears after clicking the Forgotten password link on the Login screen. 

 

Enter your ERS username and click the button.  This will take you to a ESAA security webpage.  
Follow the instructions. 
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Login screen 

Use the Login screen to log into ERS.  To display it, enter the following address in your web 
browser (Internet Explorer or similar):  http://service.tec.govt.nz. 

The login screen appears. 

1. Enter username and password. 

2. Click the Login button. 

 

 
FIELD, BUTTON, LINK COMMENTS 

Username Enter your username.  (Obtaining username and password describes how to 
obtain a username and password.) 

Password Enter your password. 
 
Notes: 

 See Obtaining username and password if you don’t have a username and 
password. 

 Use the Forgotten Password link (see below) if you have a username but 
have forgotten your password. 

Login button Enter your username and password and then click to log in. 
 
Notes: 

 For users set up to work on only one TEO, the Programmes List screen 
appears.  But for users set up to work on multiple TEOs, the Choose 
Organisation screen appears. 

 You will be automatically logged off if you stop using ERS for 30 minutes.  
You will lose any information you have not parked. 

Clear button Click to remove all text from the Username and Password fields. 

Forgotten Password link Click if you’ve forgotten your password.  The Forgotten Password screen 
appears. 

2. Click the Login 
button. 

1. Enter your username 
and password. 
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Logout screen 

Log out of ERS, like this: 
ACTION COMMENTS 

1. Click the Logout menu item 

 

2. Logout screen appears After clicking the Logout menu item, the Logout screen appears: 

 

Click Logout. 

NOTE:  If you now click the 
“Back To ERS” link, the 
Login screen reappears. 

 

IMPORTANT:  Always log out when you’ve finished, to avoid unauthorised access to ERS. 
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Quick-reference 

This summarises how to carry out various tasks in ERS: 
TOPIC ACTION HOW TO DO IT 

Enrolment Amend learner 
details 

 Click Amend link next to the learner (in the Programme Details 
screen) 

 Delete 
placement 

 Click Delete placement link next to the learner (in the Programme 
Details screen).  You may only delete an enrolment on the same day 
or when the programme has not yet started. 

 If parked, click Delete link next to the parked enrolment (in the 
Programmes List screen) 

 Enrol  Click Enrol link next to the programme (in the Programmes List 
screen); OR 

 Click Enrol link in the Programme Details screen 

 Park  Click Park button on any of the Enrolment screens: 

Personal Details 
Eligibility Details (Training Opportunities) 
Eligibility Details (Youth Guarantee) 
Statistical Information 
Travel Costs 
Pre-confirmation screen 

 Record outcome  Click Record Outcome link next to the learner (in the Programme 
Details) screen 

 Resume after 
parking 

 Click Select link next to the parked enrolment (in the Programmes List 
screen) 

 Switch to 
different 
programme 

 If you are in the Programme Details screen and want to start enrolling 
learners in a different programme, click the Home menu and return to 
the Programmes List screen. 

 Withdraw  Click Withdraw link next to the learner (in the Programme Details 
screen) 

 If the enrolment was processed in error, also send a “Placement in 
Error” form to the TEC Service Centre. 

Learner …  See relevant entries under “Enrolment” in this quick-reference 

Log in …  See descriptions under Logging in and Login screen 

Log out …  Click Logout menu 

Organisation Change  See description under Change organisation when already logged in 

Outcomes …  See relevant entries under “Enrolment” in this quick-reference 

Park …  See relevant entries under “Enrolment” in this quick-reference 

Password Change  Click User Services menu, then click “Change your password” 

Password Obtain  See description under Obtaining username and password 

Placement …  See relevant entries under “Enrolment” in this quick-reference 

Programme List all  Display Programmes List screen 

 View details  Display Programme Details screen 
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TOPIC ACTION HOW TO DO IT 

Security …  See entries in this quick-reference under: 
Log in 
Log out 
Organisation 
Password 
Username 

Username Obtain  See description under Obtaining username and password 
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